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Welcome!
Thank you for choosing Reason Essentials!

As a streamlined version of Reason, Reason Essentials comes complete with audio recording and editing, 
great-sounding and versatile effects and instruments devices, as well as all the mixing tools you need to 
sound great.

In Reason Essentials Version 8 we have focused on speed and workflow enhancements so you can work 
even faster than before. The new browser is always there, with access to your full library of songs, sounds, 
samples and instruments all the time. Drag and drop is now available throughout the Reason Essentials 
program. Create instruments by dragging a synth patch to the sequencer, drag samples directly to Redrum 
channels or create effects by dragging effect patches to the rack, for example. Reason Essentials Version 
8 also comes with brand new amp and speaker models from Softube.

Also, don't forget to visit the Propellerhead web site at www.propellerheads.se and read up on all the new 
Rack Extension instruments and effects created by ourselves and others that you can add to your rack.

A driving force for us at Propellerhead is communication with all the people around the world that use our 
programs to realize their musical ideas. And a big part of this communication takes place on our own user 
forums. This is a unique meeting place where professionals and beginners meet on equal terms to 
exchange ideas. But even more importantly, it's a forum open to you. We think you will enjoy talking to 
other Reason Essentials and Reason users all over the world, just as much as we'll enjoy talking to you.

Yours truly,

The Propellerhead Team

www.propellerheads.se

About the Reason Essentials 
documentation
This is the Installation Manual where installation of Reason Essentials and basic setting up procedures are 
described. Detailed features and operations in Reason Essentials are described in the Operation Manual, 
a file in Adobe Acrobat (".pdf") format. This and other pdf documents are installed with the program - you 
find them in the Documentation folder inside your Reason Essentials application folder. The Operation 
Manual also contains reference descriptions of all Reason Essentials devices and commands.

About the Reason Essentials operating system versions
Reason Essentials runs under Mac OS X and Windows (for operating system details, “Requirements” on 
page 12). All Reason Essentials packages contain program versions for both platforms. Everything said in 
the manuals applies to both platforms, unless explicitly stated.

http://www.propellerheads.se
http://www.propellerheads.se
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What is in the Reason Essentials 
box?
If you have purchased the boxed version of Reason Essentials, the package contains the following items:

The Reason Essentials installation DVD
This DVD contains the main Reason Essentials program installer which include the Reason Essentials 
application, Help System, Demo Songs and documentation. 

Product authorization
The license number and registration code required for the installation are printed on the DVD sleeve. The 
registration code is a one-time code used to register your Reason Essentials license to your Propellerhead 
user account. Once you have registered Reason Essentials to your account and, you don't need the 
registration code any more.

! Note that if you bought Reason Essentials from the Propellerhead web shop, it is already 
registered to your account.

The Reason Essentials download 
version
The download version of Reason Essentials contains the complete product contents. In other words, there 
is no need to purchase a boxed version. When you have downloaded the program package and installed 
the program, all you have to do is register and authorize the program and you are good to go. Refer to 
“Registering and authorizing Reason Essentials” on page 17 and “Running Reason Essentials with Internet 
Verification” on page 19 for registration and authorization details.

If you are upgrading from an earlier Reason Essentials version
! If you are upgrading from an earlier version of Reason Essentials, there are some impor-

tant things to consider before installing the new version, see “Upgrading from an earlier 
Reason Essentials version” on page 16.

If you are upgrading from Reason Essentials 1 or later (or from Propellerhead Record), you might have an 
Ignition Key which you might want to authorize for this version. You might also want to authorize your 
computer. After you have downloaded the Reason Essentials upgrade, unpacked the file and installed 
Reason Essentials, refer to “Registering and authorizing Reason Essentials” on page 17 for details on how 
to authorize Reason Essentials.

Using the Reason Essentials download version while waiting for 
the box
If you have purchased the boxed version of Reason Essentials and are waiting for the shipment, you could 
still use the download version of the program and run it with full functionality. Refer to “Registering and 
authorizing Reason Essentials” on page 17 “Running Reason Essentials with Internet Verification” on 
page 19 for details on how to proceed.
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If this is your first acquaintance with audio recording and music production software, you might also want 
to check out the “About the Audio Hardware” on page 13 and “About MIDI Interfaces” on page 14 
sections before continuing.

! When you receive the Reason Essentials box you should NOT reinstall the Reason Essen-
tials program - everything you need has already been installed from the download ver-
sion.
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Installation
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Requirements
Below you will find the minimum requirements for running Reason Essentials:

! Note that these are the minimum requirements! You will benefit from a fast computer 
with lots of RAM, since this will allow you to use more devices at the same time.

Mac OS X
• Intel Mac with dual cores (or better)
• 4 GB RAM or more
• DVD drive
• 3 GB free hard disk space (program may use up to 20 GB scratch disk space)
• Mac OS X 10.7 or later
• Monitor with at least 1280x768 resolution
• CoreAudio compliant audio interface, such as Propellerhead Balance, or built-in audio 

hardware
• A free USB2.0 port is necessary when using the Propellerhead Balance audio interface
• Internet connection for registration and Rack Extension installation
• MIDI interface and a MIDI keyboard recommended

Windows
• Intel Pentium 4/AMD Opteron with dual cores (or better)
• 4 GB RAM or more
• DVD drive
• 3 GB free hard disk space (program may use up to 20 GB scratch disk space)
• Windows 7 or later
• Monitor with at least 1280x768 resolution
• Audio Interface with ASIO driver, such as Propellerhead Balance
• A free USB2.0 port is necessary when using the Propellerhead Balance audio interface
• Internet connection for registration and Rack Extension installation
• MIDI interface and a MIDI keyboard recommended
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About the Audio Hardware
The audio hardware is the computer equipment that converts the analog signals from instruments and 
microphones to digital signals that Reason Essentials can work with and store, and back again (for 
connection to an amplifier, headphones, or similar). This equipment could be a built-in audio card, a 2 
channel USB interface, such as Propellerhead Balance, or a Firewire audio interface, or an audio card with 
several inputs and outputs, digital connectors, etc. Regardless of which, you need to make sure the 
hardware and its drivers are properly installed:

Audio hardware and Mac OS X

If you are using the Propellerhead Balance audio interface

Please refer to the Propellerhead Balance Operation Manual pdf for information on how to install, connect 
and use the Propellerhead Balance audio interface.

! Always check the Propellerhead web site for the latest Balance drivers before installing 
and connecting Balance.

If you are using the built-in audio hardware in your Macintosh

All Mac models come with a built-in audio interface, providing stereo input and output jacks (and in some 
cases a built-in microphone). Depending on your needs, the quality of these inputs and outputs may be 
fully sufficient for use with Reason Essentials. 

Reason Essentials provides a number of pre-configured Input(s)+Output(s) combinations that can be 
accessed from the Audio tab in Preferences. 

If you are using other audio hardware with your Macintosh

You may want to use other audio hardware with Reason Essentials (e.g. an audio interface with multiple 
outputs, digital connections, etc.). For this to be possible, the audio hardware must be compatible with Mac 
OS X, i.e. there must be a Core Audio driver available for the hardware.

1. Install the audio hardware drivers as described in its documentation.
Note that some audio hardware do not require any special audio drivers. Please, refer to the hardware 
documentation.

2. Connect the stereo outputs of your audio hardware to your listening equipment (speak-
ers, mixer, headphones or similar).
For info about how to use multiple outputs (i.e. more than a stereo output), see the Operation Manual 
pdf. For now, we stick to standard stereo connections.

3. If possible, test that audio plays back OK with the audio hardware.
With some audio hardware, a test application is supplied for this purpose.

Audio hardware and Windows

If you are using the Propellerhead Balance audio interface

Please refer to the Propellerhead Balance Operation Manual pdf for information on how to install, connect 
and use the Propellerhead Balance audio interface.
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If you are using other audio hardware with your Windows PC

! To run Reason Essentials with full audio in and audio out functionality under Windows, 
an ASIO driver is required for the audio hardware.

Reason Essentials can run with DirectX or MME drivers as well but this will only support audio out - 
and at considerably higher latencies than with ASIO drivers.

1. Make sure you have the latest ASIO driver for the audio hardware!
Please check the manufacturer's web site for the latest versions.

2. Install the audio hardware drivers as described in its documentation.

3. Connect the stereo outputs of your audio hardware to your listening equipment (speak-
ers, mixer, headphones or similar).
For information about how to use multiple outputs (i.e. more than a stereo output), see the Operation 
Manual pdf. For now, we stick to standard stereo connections.

4. If possible, test that audio plays back properly with the audio hardware.
In the case of audio hardware with ASIO drivers, you will need some test application for this (often in-
cluded with the audio hardware).

About MIDI Interfaces
While it is possible to use Reason Essentials without an external MIDI controller (by only using the “On-
screen Piano Keys” window for playing MIDI notes, or by manually drawing notes and automation in the 
sequencer), this would not allow you to use the program to its full potential. From now on we assume that 
you are using a keyboard controller - either a USB keyboard with a built-in MIDI interface, or a separate 
MIDI interface and a MIDI keyboard.

D When installing the MIDI interface and its drivers, follow the instructions in its documen-
tation carefully.

• While a MIDI interface with a single input is sufficient, you will benefit from having two or 
more individual inputs.
This is especially true if you want to manipulate Reason Essentials parameters with additional MIDI 
control surface devices, or use the program in conjunction with an external, stand-alone sequencer, 
drum machine or similar.

• For some MIDI interfaces connected via USB, no driver installation is required. Just plug 
in the interface and you're ready to go!

• For other, more advanced MIDI interfaces (or at least to take advantage of more ad-
vanced features, like multiple inputs) you will need to install a driver.
Please consult the documentation that came with the interface for details.

MIDI Connections
D Simply connect the USB cable from your keyboard to your computer.

Or

D Connect a MIDI cable from the MIDI Out on your MIDI keyboard (or other MIDI controller) 
to a MIDI In on your MIDI interface.
This is sufficient to be able to play and record notes and controllers in Reason Essentials from the 
MIDI keyboard.
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• If you are not using a USB keyboard, you may also connect the MIDI Out from the MIDI in-
terface to the MIDI In on your MIDI keyboard.
This is not strictly necessary to use Reason Essentials, but it will enable two-way communication when 
you run the Reason Essentials Setup Wizard which appears the first time Reason Essentials is 
launched (see “First run - Reason Essentials Setup Wizard” on page 24), or when using Auto-detect 
Surfaces in the Preferences (see “Adding a Control surface” on page 30). Whether auto-detection 
works or not depends on the keyboard model.

! If you have several MIDI control surfaces or similar that you want to use, we recommend 
that you connect them to separate MIDI ports (or directly to the computer using USB).
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Installing the Software
Upgrading from an earlier Reason Essentials version
If you are upgrading from an earlier version of Reason Essentials, there are some important things to 
remember before installing the upgrade:

! Before uninstalling your current Reason Essentials version and installing the new ver-
sion, make sure you don’t leave anything you want to keep in the Reason Essentials pro-
gram folder; the Reason Essentials program folder and its contents will be permanently 
deleted during installation of the upgrade!

For example, move any additional ReFills etc. from the Reason Essentials program folder to another 
(temporary) location before upgrading, otherwise the files might be permanently deleted.

Running the Installer
Now it's time to install the actual Reason Essentials software:

D Insert the Reason Essentials disc into your DVD drive - or unzip the download file (Win-
dows) or mount the disk image file (Mac OS X).
What to do next depends on whether you are installing on a Mac or a Windows computer.

Windows:

1. Locate the file called "Install Reason Essentials.exe" and double click it.
The installer may automatically start when you insert the DVD, depending on your system settings. 

• If you run a 64-bit Windows OS, the 64-bit version of Reason Essentials will be installed.
• If you run a 32-bit Windows OS, the 32-bit version of Reason Essentials will be installed.

! If you run a 64-bit Windows OS, but want to use the 32-bit version of Reason Essentials 
because you will be using Reason Essentials with other 32-bit ReWire applications, 
please refer to “Using Reason Essentials with ReWire on a 64-bit operating system” on 
page 21for information.

2. Follow the instructions on screen.
Before executing the installation of the software components, you will be asked to select a language, 
an install location, and whether you wish to create a program shortcut/alias on your desktop. When the 
installation is complete, you have the option of launching Reason Essentials directly.

Mac OS X:

D On the Mac, there is only a folder called “Reason Essentials” - simply drag this to the 
“Applications” folder.
Both 64-bit and 32-bit versions are included in the application. When you later launch Reason Essen-
tials, it will run in 64-bit or 32-bit mode depending on your operating system.
If you want to use the 32-bit version of Reason Essentials because you will be using Reason Essen-
tials with other 32-bit ReWire applications on your Mac, please refer to “Using Reason Essentials with 
ReWire on a 64-bit operating system” on page 21 for information.

Both platforms:

• During the installation on Windows, or during the first program launch on Mac OS X, the 
CodeMeter and Authorizer applications will be installed on your computer.
The applications are necessary for handling the Reason Essentials authorization (see below) and ad-
ministration of Rack Extension devices.
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About the Sound Bank on Mac OS X computers

The first time you launch Reason Essentials under Mac OS X, you will be asked to insert the Reason 
Essentials disc to copy the Factory Sound Bank to your hard disk. The Factory Sound Bank is one big file, 
containing a large number of patches, samples and loops, serving as your main supply of sounds (much 
like the sound ROM in a synthesizer). 

These are copied to your hard disk and are required to run the program.

The Authorization system
Reason Essentials uses an authorization system designed to be as flexible as possible, while at the same 
time providing the best possible copy protection for the product. Here's how it works:

• The core of the authorization system is your license number, which is registered to your 
user account on the Propellerhead web site.

• You can then use this license to authorize one specific computer, one optional Ignition 
Key and one Propellerhead Balance audio interface (which contains built-in Ignition Key 
hardware).
If you choose to authorize your computer, you won’t need any physical Ignition Key hardware plugged 
into the computer. During start-up Reason Essentials automatically detects that your computer is au-
thorized.
You can also choose to authorize an optional physical Ignition Key (USB stick) or Propellerhead Bal-
ance audio interface to run Reason Essentials in authorized mode, anywhere and on any computer.

• If you don't have an authorized computer or Ignition Key hardware at hand, you can still 
run Reason Essentials in authorized mode, provided that you have a working Internet 
connection.
The program will then contact the Propellerhead web site and verify that Reason Essentials is regis-
tered to your user account.

• Finally, if you don’t have an authorized computer or Ignition Key hardware at hand, nor a 
working Internet connection, you can run Reason Essentials in Demo Mode.
This is also the mode you use if you are trying out the program, but haven't yet purchased it. In this 
mode, you can work as usual and even save your work. You cannot, however, open songs in Demo 
Mode (for details, see “Running Reason Essentials in Demo Mode” on page 20).

Registering and authorizing Reason Essentials
To be able to run Reason Essentials in authorized mode (see “Running Reason Essentials on an 
authorized computer - or with an Ignition Key hardware” on page 19 and “Running Reason Essentials with 
Internet Verification” on page 19), the program must be registered to your account on the Propellerhead 
web site.

! If you purchased Reason Essentials directly from the Propellerhead web site, the Reason 
Essentials license has already been registered to your user account and you can use Rea-
son Essentials by authorizing your computer or by running with Internet Verification.

If you have purchased the optional Ignition Key (USB stick) you will want to authorize it, so please read 
on!

Here's how you register and authorize your copy of Reason Essentials.

! Note that a working Internet connection is required to be able to perform the following 
steps.
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1. Launch Reason Essentials.
When you start Reason Essentials for the first time, the following window appears:

2. Click on the “Go to your account page” link.
Your default web browser starts up and takes you to the Login page at the Propellerhead web site.

3. Enter your user name and password and log in on your Propellerhead account.
If you don't have an account already, click on the "Create account" link and follow the instructions to 
register a new account.

4. The following step depends on the situation:
If you purchased the boxed version of Reason Essentials and haven't yet registered the program, you 
will be asked to do that: 

D Enter the license number and registration code found on the DVD sleeve in the Reason 
Essentials box, then click the Register button.
A new web page appears where you are asked if you want to write your license to your computer or to 
your optional Ignition Key hardware or do it later. If you click the Later button, you will still be able to 
run Reason Essentials using Internet Verification, see “Running Reason Essentials with Internet Verifi-
cation” on page 19.

When you have registered Reason Essentials and want to write your license to your computer or Ignition 
Key:

D Click the Authorize button.
This will take you to the “Authorize Computer and Keys” page where you can choose to write your 
Reason Essentials license to your computer, to your optional Ignition Key and/or to a connected Bal-
ance interface.

5. Follow the instructions on the web page to write your licence to your computer or to your 
Ignition Key.

6. When you're done, Reason Essentials will continue launching and you will now be able to 
run the program in Authorized Mode.
You can now quit the web browser if you like.
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About deauthorizing the computer
You can authorize one computer at a time. If you're moving your work to another computer, you can first 
deauthrorize the current computer and then authorize the other one. This is done from your account page 
at the Propellerhead web site.

! Remember to deauthorize your computer before sending it to service or selling it!

Running Reason Essentials on an authorized computer - or with 
an Ignition Key hardware
If you launch Reason Essentials on an authorized computer, or with an authorized Ignition Key hardware 
(Propellerhead USB stick or Propellerhead Balance audio interface) connected, the program will simply 
start without further ado. 

q If you are using an Ignition Key, always connect the Ignition Key hardware before starting 
your computer and launching Reason Essentials. This way Reason Essentials will start up 
immediately, without the Authorization procedure.

If you have an authorized computer or an authorized Ignition Key hardware connected to your computer, 
it’s no longer necessary to have Internet connection when running Reason Essentials.

Running Reason Essentials with Internet Verification
If you launch Reason Essentials on an unauthorized computer, or without an Ignition Key hardware 
connected, the following window appears:

! Note that this requires a working Internet connection (and that your Reason Essentials 
license has been registered to your user account as described in “Registering and autho-
rizing Reason Essentials” on page 17).

D Enter the User name and Password for your Propellerhead account and click the Log in 
button.
Reason Essentials now launches in authorized mode.

! It is not possible to run two instances of Reason Essentials (on different computers) au-
thorized to the same user account. Reason Essentials will then enter Demo Mode.
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Running Reason Essentials in Demo Mode
If you don't have a Reason Essentials license, or if you don’t have an authorized computer or your optional 
Ignition Key hardware at hand and don’t have a working Internet connection, you can run Reason 
Essentials in Demo Mode:

1. Launch Reason Essentials.
The following window will show up:

2. Click on the "Demo Mode" button.
Reason Essentials launches in Demo Mode.
The Demo Mode indicator lights up to the right on the Sequencer Transport Panel:

Running Reason Essentials in demo mode allows you to perform all operations as in authorized mode, with 
three exceptions:

• You cannot export audio or bounce mixer channels to disk.
• You will not have access to any Rack Extension devices.
• You cannot open songs.

The only songs that can be opened in demo mode are the dedicated demo songs (file extension 
".reedemo"). These demo songs can be accessed from the “Open Demo Song” item in the File menu.

If you disconnect your Ignition Key hardware on an unauthorized computer, or lose the Internet Connection 
while running Reason Essentials with Internet Verification, the program will automatically enter Demo 
Mode. You can continue to work, and save your songs as usual. When you reconnect the Ignition Key 
hardware or reconnect to the internet, Reason Essentials will automatically revert to authorized mode and 
the Demo Mode indicator will go off.
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Using Reason Essentials with ReWire on a 64-bit operating 
system
If you are running a 64-bit OS, Reason Essentials will automatically install and run in 64-bit mode. 
However, if you are using ReWire, there are a couple of extra considerations:

• Both the ReWire host and Reason Essentials must run in the same mode (32-bit or 64-
bit).

• To use ReWire in 64-bit mode, the ReWire host application must have support for 64-bit 
ReWire. If not, you need to run both programs in 32-bit mode.

Here's how you run Reason Essentials in 32-bit mode under Mac and Windows, respectively:

Mac

1. Make sure Reason Essentials isn't running.

2. Select the Reason Essentials application in the Finder and choose "Get Info" from the 
File menu. 

3. Turn on the option "Open in 32-bit Mode".
The next time you launch Reason Essentials it will run in 32-bit mode.

Windows

Under Windows, you need to install a separate 32-bit version of Reason Essentials:

1. Open the Reason DVD (or the Reason Essentials download package, if you have down-
loaded the program from the web) in the Windows Explorer.

2. Right-click the "Install Reason Essentials.exe" file and select "Create Shortcut".
If the file is on the DVD, you will be asked if you want the shortcut to be placed on the desktop - click 
Yes.

3. Locate the shortcut you just created, right-click it and select "Properties".

4. On the "Shortcut" page of the Properties dialog, locate the Target field and add " /32" 
(without the quotes) at the very end. 
The Target field should say "D:\Install Reason Essentials.exe" /32
(although the drive letter may not be "D", depending on your setup).

5. Click OK.

6. Double click the shortcut file to install a 32-bit version of Reason Essentials.
The installed Reason Essentials version will have the name "Reason Essentials (32)" on the Start 
menu and desktop. You can have the regular 64-bit version installed at the same time if you like.
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About this Chapter
This chapter describes the settings you need to make before you can start using Reason Essentials. These 
are necessary in order to get any sounds to and from the program and to be able to play and control 
Reason Essentials via MIDI.

First run - Reason Essentials 
Setup Wizard
If you followed the instructions correctly in the last chapter, Reason Essentials should be running, and the 
first dialog in the "Reason Essentials Setup Wizard" guide should be open. 

This only appears the very first time the program is run.

! Note that the Language page only appears in the Windows version of Reason Essentials. 
In Mac OS X, the selected system language is used.

! Note that any setting you make in the Setup Wizard can be changed later on in the Pref-
erences dialog.



SETTING UP 25

D Clicking “Next” will take you through a series of dialogs, where the following happens:
• The Setup Wizard will first try to find a compatible audio driver.

It will automatically select the first compatible driver it finds. If this is the driver you wish to use, fine. If 
it isn't, select your preferred driver from the Audio Card Driver pop-up. If you don't know which driver to 
use, see “Setting up the Audio Hardware” on page 27.

• Next, Reason Essentials will try to auto-detect a Master Keyboard.
If one is found and you want to use this, click "Use" and proceed.

! For Reason Essentials to auto-detect a device you need two-way MIDI communication! 
Non-USB keyboard devices without a MIDI input can of course still be added manually.

! Note that your keyboard model might not be auto-detected by Reason Essentials, even 
though it’s a modern one and connects via USB. However, you can still use such a key-
board to control Reason Essentials in the same way as with an auto-detected keyboard.

• If Reason Essentials can't find the keyboard you have connected, or if you clicked "Don't 
Use", you will be asked to specify a Master Keyboard manually.
This is done by first selecting a manufacturer, and then a model. If your model keyboard isn't on this list 
select "Other".

D You will also have to specify a MIDI port to use.
This can be done either by selecting one of the available ports listed in the popup, or by clicking the 
"Find…" button and pressing some keys on your keyboard.

D Note that if you have additional remote control surface devices in your setup, these will 
have to be added in the Preferences - see “Adding a Control surface” on page 30.
The Setup Wizard will only establish a connected Master Keyboard device.

Setup is now complete!

If all went well, you should now have established audio and MIDI communication - the basics needed to 
record and play back audio and to direct MIDI to Reason Essentials!

However, if for any reason the Setup Wizard failed to establish the necessary settings, or if you wish to add 
other devices etc., you will have to make your settings in the Preferences dialog (see below).

D Select which song to open, and if you want to watch the Getting Started Tutorials on the 
Propellerhead web site.

The final page of the Setup Wizard let's you select if you want to open a Demo Song, a template document, 
or an empty song directly after finishing the Setup Wizard. It also gives you an option to watch Getting 
Started video tutorials on the Propellerhead web site.
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About the Preferences
The basic settings for audio and MIDI are done in the Preferences dialog. This is opened from the Edit 
menu (or, if you are running Mac OS X, from the Reason Essentials menu). 

The Preferences dialog.

q Described herein are only the most important settings in the Preferences. For informa-
tion about other Preferences settings, see the “Menu and Dialog Reference” chapter in 
the Reason Essentials Operation Manual pdf.
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Setting up the Audio Hardware
In case this wasn't done in the Setup Wizard, you need to establish a connection between Reason 
Essentials and the audio hardware. This is done by selecting a driver - a software component that acts like 
a link between the program and the audio hardware. Proceed as follows:

1. In the Preferences dialog, click the Audio tab.

2. Pull down the Audio card driver pop-up menu and select one of the available drivers.
Which driver to select depends on the platform and the audio hardware. If an option is not applicable to 
your setup it will be disabled in the dialog.
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Mac OS X

D Select the option that corresponds to the hardware you want to use (the built-in audio 
connectors or some additional audio hardware that you have installed).

q A number of predefined combinations of built-in inputs and outputs will also be available 
in the Audio Card Driver pop-up.
The number of available input(s)+output(s) combinations depends of your computer’s specific audio 
hardware configuration.

Windows

! If you run Reason Essentials under Windows, it’s required that the audio hardware sup-
ports ASIO drivers, otherwise you won’t be able to record any audio.

D Select the option that corresponds to the ASIO hardware you want to use.
If you are using audio hardware for which there is a specific ASIO driver, you should select this.
With an ASIO driver written specifically for the audio hardware, Reason Essentials can communicate 
more or less directly with the audio hardware. The benefits are lower latency (see below) and possibly 
better support for additional hardware features such as multiple inputs and outputs.

About Latency and other Audio Settings

On the Audio tab, you will find a number of additional settings for audio. The most important ones are 
Buffer Size and the corresponding readouts for Input and Output Latency. 

The Input Latency is the delay between when the audio is “sent” from a connected microphone or 
instrument and when it’s received and detected by Reason Essentials. Output Latency is the delay 
between when audio is “sent” from Reason Essentials and when you actually hear it. The latencies in an 
audio system depends on your audio hardware, its drivers and their settings.

When you select a driver, its latency values are automatically reported by the audio card and displayed in 
the on the Audio tab in Preferences. Depending on the audio hardware and the driver, you may be able to 
adjust these values. If you experience high latency values, you will need to make adjustments to your 
configuration. 

D If available, use the Buffer Size slider to lower the latency. 
The lowest buffer size setting you can choose depends on the audio drivers and your computer's per-
formance. If you get crackles and glitches during playback, the buffer size is set too low for your sys-
tem - you need to raise the buffer size until you can play back normally.

D If the Buffer Size slider is disabled, you may be able to lower the buffer size in the control 
panel for the audio hardware - click the Control Panel button to open this.

For more information, please consult the Reason Essentials Operation Manual pdf.
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Setting up MIDI Control Surfaces
In Reason Essentials, MIDI keyboards or remote control devices are called control surfaces. MIDI input 
from control surfaces is handled by a system called Remote. Here are some of the main features:

• You can use any number of control surfaces at the same time.
• The program supports a large number of control surfaces out of the box - knobs, faders 

and buttons on the surfaces are automatically mapped to the most useful parameters on 
the Reason Essentials devices.
You don't have to change the settings on the control surface to control different devices in Reason Es-
sentials - if you change MIDI input from a ID-8 track to a Combinator track, the control surface will au-
tomatically adapt. You just set up your control surface once and for all for use with Reason Essentials 
- the program handles the rest!

• For control surfaces that are not natively supported at this stage, you can use generic 
drivers.
Note however, that Remote drivers for additional control surfaces will be added continuously - check 
our web page for more info.

• By default, all control surfaces follow the sequencer Master Keyboard Input.
This means that you set MIDI input to a track in the sequencer to route the control surface(s) to the 
track's device in the rack.

• You can lock a control surface to a specific device in the rack.
For example, you could have a Master Keyboard that follows MIDI input, while another control surface 
is locked to the Main Mixer. This way you can control levels and pans at all times. This is described in 
the Operation Manual.

• You can use remote overrides to map a specific control on a surface to a specific Reason 
Essentials parameter or function.
For example, you could override-map a knob or fader on your control surface to the Main Mixer's mas-
ter level fader. Or you could map buttons on your control surface to control Reason Essentials's trans-
port (play, stop, record, etc.) at all times, regardless of which track has Master Keyboard Input in the 
sequencer. This is described in the Operation Manual.

• Remote also supports some control surfaces with MIDI feedback.
If you have such a control surface and it is supported by Reason Essentials, you can take full advan-
tage of motorized faders, meters, displays, etc.

Among the Reason Essentials documentation you will find a pdf document called "Control Surface 
Details". This contains useful information about the supported control surfaces. 

In case you specified a Master Keyboard in the Setup Wizard, and you don't have any other control 
surfaces, you don't have to do anything else. But if you want to add additional control surfaces or edit your 
settings, this is done in the Preferences.
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Adding a Control surface
1. Open the Preferences dialog and click the Control surfaces tab.

2. If your control surface is connected via USB (or if you have made a two-way MIDI connec-
tion), try clicking the Auto-detect Surfaces button.
Reason Essentials scans all MIDI ports and tries to identify the connected control surfaces. Note that 
not all control surfaces support auto-detection.

All found surfaces are listed in the Attached Surfaces list. 

3. To add a control surface manually, click the Add button.
This brings up a new dialog.
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4. Select the manufacturer of your control surface from the Manufacturer pop-up menu.
If you can't find it on the menu, see below.

5. Select the model of your control surface from the Model pop-up menu.
If you can't find it on the menu, see below.

6. An image of the selected control surface model is shown, often along with some informa-
tion text - read this carefully.
For some control surfaces, you need to select a specific preset to use the surface with Reason Essen-
tials - this is noted here.

7. Use the MIDI Input pop-up to select the input port to which you have connected the sur-
face.
If in doubt, you can click the Find button and then tweak a control or play a key on the control surface 
to have Reason find the correct input port for you.

• Some control surfaces may have more than one MIDI Input pop-up menu.
You need to select ports on all MIDI Input pop-up menus.

• Some control surfaces will have a MIDI Output pop-up menu.
In some cases this labeled "Optional" - then you don't have to make a selection. In other cases, a MIDI 
Output is required. This is the case if the control surface uses MIDI feedback - motor fader, displays, 
etc.

8. If you like, you can rename your control surface in the Name field.

9. Click OK to add the surface.
Depending on the surface model, alerts may appear, reminding you to select a specific preset etc.
In some cases, Reason Essentials can restore a preset in the control surface to factory settings for you 
- you are then informed of this.

Finally you return to the Control surfaces tab in Preferences, where your added surface is now listed.
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If your control surface model isn't listed

If you can't find your control surface listed on the Manufacturer or Model pop-up menus when you try to 
add it, this means that there's no native support for that model. However, the program supports generic 
keyboards and controllers. Here's what to do:

D Select "Other" on the Manufacturer pop-up menu and then select one of the three op-
tions on the Model pop-up menu.

Or, if the Manufacturer is listed but not your specific model:

D Select one of the three "Other" options on the Model pop-up menu:

In both cases, the options are:

• MIDI Control Keyboard 
Select this if you have a MIDI keyboard with programmable knobs, buttons or faders. You need to set 
up your MIDI control keyboard so that the controllers send the correct MIDI CC messages, depending 
on which Reason Essentials device you want to control - check out the MIDI Implementation Chart in 
the Reason Essentials documentation. If your control surface has templates or presets for different 
Reason Essentials devices, these can be used.

• MIDI Control Surface 
Select this if you have a MIDI controller with programmable knobs, buttons or faders (but without key-
board). Again, you need to set your controllers to send the correct MIDI CCs.

• MIDI Keyboard (No Controls)
Select this if you have a MIDI keyboard without programmable knobs, buttons or faders. This is used 
for playing only (including performance controllers such as pitch bend, mod wheel, etc.) - you cannot 
adjust Reason Essentials device parameters with this type of control surface.

• MIDI Multichannel Control Keyboard/Surface
These options can be used if your MIDI keyboard or surface can handle multiple MIDI channels simul-
taneously.

After selecting a model, proceed with selecting MIDI input as described above.

About the Master Keyboard

One of the control surfaces can be the Master Keyboard. This is like any other control surface, but it must 
have a keyboard and it cannot be locked to a specific Reason Essentials device (in other words, it always 
follows the MIDI input to the sequencer). This is the surface you use to play the instrument devices in 
Reason Essentials.

• The first surface with a keyboard that is added (or found by auto-detect) is automatically 
selected to be the Master Keyboard.
This is shown in the Attached Surfaces list on the Preferences page.

D If you want to use another surface as Master Keyboard, select it in the list and click the 
"Make Master Keyboard" button.
You can only have one Master Keyboard.

D If you don't want to use any Master Keyboard at all, select the current Master Keyboard 
surface and click the same button (which is now labeled "Use No Master Keyboard").
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Master Keyboard Input

This allows you to set a preference for how Master Keyboard Input mode is selected:

• Standard mode
This always sets Master Keyboard Input to the selected track.

• Separated mode
This will allow you to independently select tracks while Master Keyboard Input is unchanged. When 
this is mode is active, Master Keyboard Input is set by clicking the device icon in the track list. Select-
ing another track (by clicking on the track name or somewhere in the track list), leaves Master Key-
board Input unchanged.

Other functions

D To edit a surface, double-click it in the list (or select it and click Edit).
This lets you change its name and MIDI port settings, if needed.

D To delete a surface, select it in the list and click Delete.

D You can turn off a surface by deactivating its "Use with Reason Essentials" checkbox.
This could be useful if the surface is connected to your system but you only want to use it with another 
program, etc.

• There is also a "Sync" page in the Preferences.
This is only used for External Control MIDI buses and for MIDI Clock Sync input. All hands-on MIDI 
control is set up on the Control surfaces page.
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Setting up the Default Song
It's possible to select a default Song which will automatically open as a "template" each time you select 
"New" from the File menu. The Default Song could be any Song you have created earlier, or a factory 
made Template Song. You can select this Default Song on the General tab in Preferences. 

1. Select "Preferences" from the Edit menu (Win) or "Reason Essentials" menu (Mac) and 
then click the General tab.

2. Click the "Template" radio button in the "Default Song" section. 

3. Click the folder icon to the right and select the Song you want to use as template when 
creating new Songs. 
Each time you create a new Song (by selecting "New" from the File menu), the selected Song will be 
loaded and used as a template for your new Song. On Windows platforms, the Song document will be 
named "Document n" where "n" is an incremental number. On Mac OS X platforms, the document will 
be named "untitled n" where "n" is an incremental number. You can then save your Song with a new 
name.

Opening the last Song at program launch 
It's possible to instruct Reason Essentials to automatically open the last Song each time you launch 
Reason Essentials. You select this on the General tab in the Preferences dialog. 

1. Select "Preferences" from the Edit menu (Win) or "Reason Essentials" menu (Mac) and 
then click the General tab. 

2. Tick the "Load Last Song On Startup" checkbox. 
When you launch Reason Essentials the next time, the last saved Song will automatically open in a 
document window.
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Reassigning the Function Keys in 
Mac OS X
When you work with Reason Essentials, you will do a lot of navigating between the three main areas - the 
main mixer, the rack and the sequencer. The quickest way to switch between these areas is to use the 
function keys F5, F6 and F7 (see “Navigating between the areas” in the “Common Operations and 
Concepts” chapter in the Operation Manual and Help system for details). Also, the F3, F4 and F8 keys are 
shortcuts for showing and hiding the Browser, On-screen Piano Keys window and the Tool Window, 
respectively.

However, on many Macintosh models (especially MacBooks), the function keys double as hardware 
control buttons. For example, they might control the volume of the built-in speaker, the display brightness 
or keyboard backlight. To make these keys actually work as function keys for software such as Reason 
Essentials, you need to hold the "Fn" key while pressing them.

This can work perfectly OK, but to get the best workflow in Reason Essentials we recommend that you 
change this behavior, so that pressing e.g. the F5 key actually sends "F5" to Reason Essentials (and you 
hold down the Fn key to get the hardware control functions instead). Here is how you change this:

1. Open the System Preferences in Mac OS X and select the "Keyboard" item.
The "Keyboard" preferences are shown.

2. Select the "Keyboard" tab and make sure the checkbox "Use all F1, F2, etc. keys as stan-
dard function keys" is ticked.
Now you can use F3-F8 for controlling functions in Reason Essentials. To use hardware control fea-
tures such as volume and display brightness, you need to hold down the "Fn" key before pressing the 
function keys.

Some function keys might also be pre-assigned to Mac OS X keyboard shortcuts, which will have priority 
over software such as Reason Essentials. This is easily changed:

3. Click the “Keyboard Shortcuts” tab in the “Keyboard” window.
The Keyboards Shortcuts Preferences window shows lists of keyboard shortcuts assigned to system 
functions. For example, [Cmd]-[F5] in the Accessibility group is assigned to turn VoiceOver on or off. In 
Reason Essentials, this is the keyboard shortcut for detaching the main mixer into a separate window.
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4. Scroll down to the "Turn VoiceOver on or off" item in the Accessibility group and either 
remove the tick from the checkbox or assign it to another keyboard shortcut.

5. Now, you’re finished with the settings and can close the “Keyboard” window.
From now on, the function keys and keyboard shortcuts will perform their intended functions in Rea-
son Essentials.
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